
Security Audit Reports 

Setup 

Guide

PV6.2.0 SV102



Copyright © 2025 OneStream Software LLC. All rights reserved.

Any warranty with respect to the software or its functionality will be expressly given in the

Subscription License Agreement or Software License and Services Agreement between

OneStream and the warrantee. This document does not itself constitute a representation or

warranty with respect to the software or any related matter.

OneStream Software, OneStream, Extensible Dimensionality, and the OneStream logo are

trademarks of OneStream Software LLC in the United States and other countries. Microsoft,

Microsoft Azure, Microsoft Office, Windows, Windows Server, Excel, Internet Information

Services, Windows Communication Foundation and SQL Server are registered trademarks or

trademarks of Microsoft Corporation in the United States and/or other countries. DevExpress is a

registered trademark of Developer Express, Inc. Cisco is a registered trademark of Cisco

Systems, Inc. Intel is a trademark of Intel Corporation. AMD64 is a trademark of Advanced Micro

Devices, Inc. Other names may be trademarks of their respective owners.



Table of Contents

Overview 1

User Reports 1

Group Reports 2

Setup & Installation 3

Dependencies 3

Select the Security Audit Reports Development Location 3

Create the OneStream Development Application 4

Application Server Settings 4

Configure the OneStream Application Server 5

Application Server Settings 6

Configure the OneStream Application Server 6

Install Security Audit Reports 8

Set Up Security Audit Reports 8

Package Contents 9

Security Audit Reports Setup Instructions i

Table of Contents



Business Rules 9

Set Up Security Audit Reports 9

Package Contents 10

Business Rules 10

Set Up Security Audit Reports 10

Package Contents 11

Business Rules 11

Settings 12

Global Options 12

Security Role (Access Security Audit Reports) 12

Assign User Group to Security Role 13

Global Options 13

Security Role (Access Security Audit Reports) 13

Assign User Group to Security Role 14

Global Options 14

Security Role (Access Security Audit Reports) 14

Security Audit Reports Setup Instructions ii

Table of Contents



Assign User Group to Security Role 15

Uninstall 16

Security Audit Reports 17

Run a Report 17

User and Group Report Filters 18

Stop Button 20

User and Group Report Filters 20

Stop Button 22

User Reports/Group Reports Panes 22

Report Viewer Button Bar 23

Print 23

Navigation 23

Zoom 24

View 25

Export 25

Report Viewer Button Bar 25

Security Audit Reports Setup Instructions iii

Table of Contents



Print 25

Navigation 26

Zoom 26

View 27

Export 27

Report Viewer Button Bar 27

Print 27

Navigation 28

Zoom 28

View 29

Export 29

Report Viewer Button Bar 29

Print 29

Navigation 30

Zoom 30

View 31

Security Audit Reports Setup Instructions iv

Table of Contents



Export 31

Report Viewer Button Bar 32

Print 32

Navigation 32

Zoom 33

View 34

Export 34

Report Viewer Button Bar 34

Print 35

Navigation 35

Zoom 35

View 36

Export 36

Report Navigation 36

Document Map Tab 37

Pages Tab 37

Security Audit Reports Setup Instructions v

Table of Contents



Search Results 39

Report Navigation 39

Document Map Tab 40

Pages Tab 40

Search Results 42

Report Navigation 42

Document Map Tab 43

Pages Tab 43

Search Results 45

Report Navigation 46

Document Map Tab 46

Pages Tab 47

Search Results 48

User Reports 49

Total Users 49

Enabled Users 51

Security Audit Reports Setup Instructions vi

Table of Contents



Disabled Users 51

Native Users 52

Added Users 52

Deleted Users 53

Updated Users 54

Inactive Users 55

User List 55

User List – Grid View 57

Manage Grid Items 57

User List – Grid View 62

Manage Grid Items 62

User Change Audit 67

User’s Group Membership 68

User’s Group Change Audit 69

User Security Roles 69

User Deactivation 70

Security Audit Reports Setup Instructions vii

Table of Contents



Group Reports 72

Total Groups 72

Added Groups 73

Deleted Groups 74

Updated Groups 75

Group List 76

Group Change Audit 77

Help & Miscellaneous Information 78

Display Settings 78

Package Contents & Naming Conventions 78

Solution Database Migration Advice 79

OneStream Solution Modification Considerations 81

Security Audit Reports Setup Instructions viii

Table of Contents



Overview
The Security Audit Reports solution provides business users with an overview of user and

group information for internal security audit purposes.

User Reports
User details are displayed in the following reports generated by the Security Audit

Reports dashboard:

l Total Users

l Enabled Users

l Disabled Users

l Native Users

l Added Users

l Deleted Users

l Updated Users

l Inactive Users

l User List

l User List – Grid View

l User Change Audit

l User’s Group Membership

l User’s Group Change Audit
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l User’s Security Roles

l User Deactivation

Group Reports
Group details are displayed in the following reports generated by the Security Audit

Reports dashboard:

l Total Groups

l Added Groups

l Deleted Groups

l Updated Groups

l Group List

l Group Change Audit
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Setup & Installation
This section contains important details related to the planning, configuring, and

installation of your solution. Before you install the solution, familiarize yourself with these

details.

See OneStream Solution Modification Considerations.

Dependencies

Component Description

OneStream 6.2.0 or

later

MinimumOneStream Platform version required to install

this version of Security Audit Reports.

Select the Security Audit Reports
Development Location
Before installation, decide whether to build the solution directly in the Production

OneStream application or in a separate Development OneStream application. This

section provides some key considerations for each option.

Production OneStream Application: The primary advantage of building the solution in
a Production application is that you will not have to migrate the resulting work from a

Development application. However, there are intrinsic risks when making design changes

to an application used in a Production capacity and it is not advised.
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NOTE: OneStream strongly recommends that you implement the solution in the

Development environment with a fresh copy of the Production application before

starting work.

Development OneStream Application: As a best practice, use the Development
OneStream application to build the solution.

Create the OneStream Development
Application
1. Ensure all the OneStream artifacts relating to Security Audit Reports such as

Workflow Profiles and Entities are in the Production application.

2. Copy your Production OneStream application to your Development environment

and rename it. This Development version is used for your Security Audit Reports

project.

Application Server Settings
You may need to edit the OneStream Application Server Configuration so users can

create and change data in the additional database tables. If other OneStream Solutions

(such as Specialty Planning) are already in the application, these adjustments may

already exist.

See Solution Database Migration Advice
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Configure the OneStream Application Server
Be sure that the security group settings include the users who work on and set up the

solution before proceeding.

NOTE: Group settings are applicable to all OneStream Solutions; it is important

to keep the group names generic.

1. Start the OneStream Server Configuration Utility as an Administrator.

2. ClickOpen Application Server Configuration File > Database.

3. Edit the followingOneStream Database Server properties:

l Access Group for Ancillary Tables: Select a group that includes those who will
access records.

l Can Create Ancillary Tables: True

l Can Edit Ancillary Table Data: True

l Maintenance Group for Ancillary Tables: Select a group to edit and maintain
tables.

l Table Creation Group for Ancillary Tables: Select a group who can create
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tables.

4. Restart Internet Information Server.

Application Server Settings
You may need to edit the OneStream Application Server Configuration so users can

create and change data in the additional database tables. If other OneStream Solutions

(such as Specialty Planning) are already in the application, these adjustments may

already exist.

See Solution Database Migration Advice

Configure the OneStream Application Server
Be sure that the security group settings include the users who work on and set up the

solution before proceeding.

NOTE: Group settings are applicable to all OneStream Solutions; it is important

to keep the group names generic.
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1. Start the OneStream Server Configuration Utility as an Administrator.

2. ClickOpen Application Server Configuration File > Database.

3. Edit the followingOneStream Database Server properties:

l Access Group for Ancillary Tables: Select a group that includes those who will
access records.

l Can Create Ancillary Tables: True

l Can Edit Ancillary Table Data: True

l Maintenance Group for Ancillary Tables: Select a group to edit and maintain
tables.

l Table Creation Group for Ancillary Tables: Select a group who can create
tables.

4. Restart Internet Information Server.
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Install Security Audit Reports
1. On the OneStream Solution Exchange, go toOneStream Solutions > Security

Audit Reports.

2. On the Security Audit Reports Solution page, select the appropriate OneStream

platform version from theMinimum Platform Version drop-down list.

3. Select the most recent version from the Solution Version drop-down list and click
Download.

4. Log in to OneStream.

5. On the Application tab, click Tools > Load/Extract.

6. On the Load tab, locate the solution package using the Select File icons and click
Open.

7. When the solution’s file name appears, click Load.

8. Click Close to complete the installation.

Set Up Security Audit Reports
l In OneStream, click Community Solution > Dashboards > Security Audit
Reports > Security Audit Reports.
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Package Contents
The Dashboard Maintenance Unit provides the user interface for Security Audit Reports

and includes the required Dashboard Groups, Components, Data Adapters, Parameters

and files.

Business Rules
The following Business Rules are included:

l SAR_HelperQueries

l SAR_SolutionHelper

l SAR_ParamHelper

Set Up Security Audit Reports
l In OneStream, click Community Solution > Dashboards > Security Audit
Reports > Security Audit Reports.
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Package Contents
The Dashboard Maintenance Unit provides the user interface for Security Audit Reports

and includes the required Dashboard Groups, Components, Data Adapters, Parameters

and files.

Business Rules
The following Business Rules are included:

l SAR_HelperQueries

l SAR_SolutionHelper

l SAR_ParamHelper

Set Up Security Audit Reports
l In OneStream, click Community Solution > Dashboards > Security Audit
Reports > Security Audit Reports.
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Package Contents
The Dashboard Maintenance Unit provides the user interface for Security Audit Reports

and includes the required Dashboard Groups, Components, Data Adapters, Parameters

and files.

Business Rules
The following Business Rules are included:

l SAR_HelperQueries

l SAR_SolutionHelper

l SAR_ParamHelper
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Settings

The Settings page contains theGlobal Options and Uninstall tabs.

Global Options
TheGlobal Options page contains key properties that guide global Security Audit
Reports administration. It should be the first page accessed during the initial setup and

configuration of Security Audit Reports.

NOTE: All global option settings are retained during solution upgrades.

Security Role (Access Security Audit Reports)
Since security is governed at the global level, it is the assignment of the user group to the

Security Role that determines who will be global Security Audit Reports Administrators.

This group is granted access to all areas of Security Audit Reports and are the only users

who can see the Settings Page icon.
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Assign User Group to Security Role
l ClickGlobal Options, select the user group from the drop-down list (the default

value is Administrators), and click Save.

Global Options
TheGlobal Options page contains key properties that guide global Security Audit
Reports administration. It should be the first page accessed during the initial setup and

configuration of Security Audit Reports.

NOTE: All global option settings are retained during solution upgrades.

Security Role (Access Security Audit Reports)
Since security is governed at the global level, it is the assignment of the user group to the

Security Role that determines who will be global Security Audit Reports Administrators.

This group is granted access to all areas of Security Audit Reports and are the only users

who can see the Settings Page icon.
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Assign User Group to Security Role
l ClickGlobal Options, select the user group from the drop-down list (the default

value is Administrators), and click Save.

Global Options
TheGlobal Options page contains key properties that guide global Security Audit
Reports administration. It should be the first page accessed during the initial setup and

configuration of Security Audit Reports.

NOTE: All global option settings are retained during solution upgrades.

Security Role (Access Security Audit Reports)
Since security is governed at the global level, it is the assignment of the user group to the

Security Role that determines who will be global Security Audit Reports Administrators.

This group is granted access to all areas of Security Audit Reports and are the only users
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Assign User Group to Security Role
l ClickGlobal Options, select the user group from the drop-down list (the default

value is Administrators), and click Save.
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Uninstall
The Uninstall feature allows the Security Audit Reports User Interface or the entire

solution to be uninstalled. Note that if part of an upgrade, any modifications performed on

standard Security Audit Reports objects will be removed.

Click Uninstall UI to remove Security Audit Reports. This includes related dashboards
and business rules but leaves the database and related tables in place. For some

releases, you should perform this before accepting any new version of Security Audit

Reports, since some of the dashboards or other objects may have been modified.

The Security Audit Reports Release Notes indicate if an overinstall is supported.
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Security Audit Reports
Security Audit Reports is a self-contained solution based on SQL adapters with

all reports designed in OneStream . It is ready for use as soon as it is imported

into the application.

Run a Report
1. Click the name of the report you want to view.

2. Select or enter values in the fields above the report to filter the data shown in the

report. For date fields, enter the dates in your local date format, for example

MM/DD/YYYY.

3. Click Refresh or Run to display the report.
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NOTE: You can change one or both dates of a reporting period as frequently as
needed. Click Refresh or Run after each change to update the results.

See User and Group Report Filters for descriptions of the filters you can apply to each

report.

User and Group Report Filters
Security Audit reports have filters that you can apply to further define the user or group

information you want to view. Filters available for a specific report appear in the header

bar above the report.

Start Date/End Date
You must specify a date range for the data to be included in the report. Select a start date

and end date to specify the date range, then click Refresh or Run.

Enabled
This filter is available with the following reports:

l Inactive Users

l User List

l User’s Group Membership

l User’s Security Roles

Click the Enabled drop-down and specify whether you want to show enabled (True),
disabled (False), or all (Both) users listed on the report.

Name
This filter is available with the User’s Group Membership and User’s Security Roles
reports only. Type the name of a single user by which to filter the report. The name you
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enter must be a valid user.

Description
This filter is available with the User’s Group Membership and User’s Security Roles
reports only. Type a description by which to filter the report. The description you enter

must be a valid description.

Text1, Text2, Text3, Text4
These are freeform text fields you can use to further identify a user or group users based

on common text in one of these fields. These filters are available with the User’s Group
Membership and User’s Security Roles reports only.

Type descriptive text in any of these fields.
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Stop Button
While security reports are printing to the Report pane, a Stop button appears at the
bottom of the pane. Use this button to stop the report from completing.

User and Group Report Filters
Security Audit reports have filters that you can apply to further define the user or group

information you want to view. Filters available for a specific report appear in the header

bar above the report.

Start Date/End Date
You must specify a date range for the data to be included in the report. Select a start date

and end date to specify the date range, then click Refresh or Run.

Enabled
This filter is available with the following reports:

l Inactive Users

l User List

l User’s Group Membership

l User’s Security Roles

Click the Enabled drop-down and specify whether you want to show enabled (True),
disabled (False), or all (Both) users listed on the report.

Name
This filter is available with the User’s Group Membership and User’s Security Roles
reports only. Type the name of a single user by which to filter the report. The name you

enter must be a valid user.
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Description
This filter is available with the User’s Group Membership and User’s Security Roles
reports only. Type a description by which to filter the report. The description you enter

must be a valid description.

Text1, Text2, Text3, Text4
These are freeform text fields you can use to further identify a user or group users based

on common text in one of these fields. These filters are available with the User’s Group
Membership and User’s Security Roles reports only.

Type descriptive text in any of these fields.
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Stop Button
While security reports are printing to the Report pane, a Stop button appears at the
bottom of the pane. Use this button to stop the report from completing.

User Reports/Group Reports Panes
The User Reports andGroup Reports panes display to the left of the Report Viewer
pane. These panes list the available Security Audit user and group reports. User and

group reports that include a count of the matching records also display that count next to

the report name, as shown in the following graphic.
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Click the name of a report in either of these panes to view the report with default filtering

applied to the report.

Report Viewer Button Bar
While viewing a report, you can use buttons in the Report Viewer button bar to navigate

through the report, set viewing options, zoom in and out of parts of the report, and print or

export the report.

Print
Use the Print andQuick Print buttons to control report printing. The Print button displays
the Windows Print dialog box, set the printer and other print settings for precise printing.
ClickQuick Print to send the report to your default printer with specified print settings.

Navigation
Use these buttons to control navigation through the report.

Click Previous Page and Next Page to navigate through the document one page at a
time. Click First Page and Last Page to go to the first and last pages in the document.

For some reports you can click Navigation Pane to display a navigation pane next to the
Report Viewer, which lets you find specific data on the report.

See Report Navigation.
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Zoom
Use these buttons to control the magnification for the report. The Zoom In and Zoom Out
buttons increment or decrement the magnification. Use the Zoom button to view the

report at a specific magnification, view the entire page, or display pages using the entire

Report Viewer pane width.
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View
Use the Page Layout button to specify the number of pages to display within the Report
Viewer pane, or to select the number of pages to show side-by-side. The Enable
Continuous Scrolling button lets you control scrolling between pages in single or
double-page view. Click Show Cover Page to navigate to the first page of the current
report.

Export
The Export buttons let you export the document for sharing with others. Click Export and
select an output type to export the document in the specified file format, using the Export
Document dialog box to specify the location for the output file. Click Send to export the
document in an available format and send the document in an email.

Report Viewer Button Bar
While viewing a report, you can use buttons in the Report Viewer button bar to navigate

through the report, set viewing options, zoom in and out of parts of the report, and print or

export the report.

Print
Use the Print andQuick Print buttons to control report printing. The Print button displays
the Windows Print dialog box, set the printer and other print settings for precise printing.
ClickQuick Print to send the report to your default printer with specified print settings.
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Navigation
Use these buttons to control navigation through the report.

Click Previous Page and Next Page to navigate through the document one page at a
time. Click First Page and Last Page to go to the first and last pages in the document.

For some reports you can click Navigation Pane to display a navigation pane next to the
Report Viewer, which lets you find specific data on the report.

See Report Navigation.

Zoom
Use these buttons to control the magnification for the report. The Zoom In and Zoom Out
buttons increment or decrement the magnification. Use the Zoom button to view the

report at a specific magnification, view the entire page, or display pages using the entire

Report Viewer pane width.
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View
Use the Page Layout button to specify the number of pages to display within the Report
Viewer pane, or to select the number of pages to show side-by-side. The Enable
Continuous Scrolling button lets you control scrolling between pages in single or
double-page view. Click Show Cover Page to navigate to the first page of the current
report.

Export
The Export buttons let you export the document for sharing with others. Click Export and
select an output type to export the document in the specified file format, using the Export
Document dialog box to specify the location for the output file. Click Send to export the
document in an available format and send the document in an email.

Report Viewer Button Bar
While viewing a report, you can use buttons in the Report Viewer button bar to navigate

through the report, set viewing options, zoom in and out of parts of the report, and print or

export the report.

Print
Use the Print andQuick Print buttons to control report printing. The Print button displays
the Windows Print dialog box, set the printer and other print settings for precise printing.
ClickQuick Print to send the report to your default printer with specified print settings.
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Navigation
Use these buttons to control navigation through the report.

Click Previous Page and Next Page to navigate through the document one page at a
time. Click First Page and Last Page to go to the first and last pages in the document.

For some reports you can click Navigation Pane to display a navigation pane next to the
Report Viewer, which lets you find specific data on the report.

See Report Navigation.

Zoom
Use these buttons to control the magnification for the report. The Zoom In and Zoom Out
buttons increment or decrement the magnification. Use the Zoom button to view the

report at a specific magnification, view the entire page, or display pages using the entire

Report Viewer pane width.
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View
Use the Page Layout button to specify the number of pages to display within the Report
Viewer pane, or to select the number of pages to show side-by-side. The Enable
Continuous Scrolling button lets you control scrolling between pages in single or
double-page view. Click Show Cover Page to navigate to the first page of the current
report.

Export
The Export buttons let you export the document for sharing with others. Click Export and
select an output type to export the document in the specified file format, using the Export
Document dialog box to specify the location for the output file. Click Send to export the
document in an available format and send the document in an email.

Report Viewer Button Bar
While viewing a report, you can use buttons in the Report Viewer button bar to navigate

through the report, set viewing options, zoom in and out of parts of the report, and print or

export the report.

Print
Use the Print andQuick Print buttons to control report printing. The Print button displays
the Windows Print dialog box, set the printer and other print settings for precise printing.
ClickQuick Print to send the report to your default printer with specified print settings.
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Navigation
Use these buttons to control navigation through the report.

Click Previous Page and Next Page to navigate through the document one page at a
time. Click First Page and Last Page to go to the first and last pages in the document.

For some reports you can click Navigation Pane to display a navigation pane next to the
Report Viewer, which lets you find specific data on the report.

See Report Navigation.

Zoom
Use these buttons to control the magnification for the report. The Zoom In and Zoom Out
buttons increment or decrement the magnification. Use the Zoom button to view the

report at a specific magnification, view the entire page, or display pages using the entire

Report Viewer pane width.
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View
Use the Page Layout button to specify the number of pages to display within the Report
Viewer pane, or to select the number of pages to show side-by-side. The Enable
Continuous Scrolling button lets you control scrolling between pages in single or
double-page view. Click Show Cover Page to navigate to the first page of the current
report.

Export
The Export buttons let you export the document for sharing with others. Click Export and
select an output type to export the document in the specified file format, using the Export
Document dialog box to specify the location for the output file. Click Send to export the
document in an available format and send the document in an email.
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Report Viewer Button Bar
While viewing a report, you can use buttons in the Report Viewer button bar to navigate

through the report, set viewing options, zoom in and out of parts of the report, and print or

export the report.

Print
Use the Print andQuick Print buttons to control report printing. The Print button displays
the Windows Print dialog box, set the printer and other print settings for precise printing.
ClickQuick Print to send the report to your default printer with specified print settings.

Navigation
Use these buttons to control navigation through the report.

Click Previous Page and Next Page to navigate through the document one page at a
time. Click First Page and Last Page to go to the first and last pages in the document.

For some reports you can click Navigation Pane to display a navigation pane next to the
Report Viewer, which lets you find specific data on the report.

See Report Navigation.
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Zoom
Use these buttons to control the magnification for the report. The Zoom In and Zoom Out
buttons increment or decrement the magnification. Use the Zoom button to view the

report at a specific magnification, view the entire page, or display pages using the entire

Report Viewer pane width.
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View
Use the Page Layout button to specify the number of pages to display within the Report
Viewer pane, or to select the number of pages to show side-by-side. The Enable
Continuous Scrolling button lets you control scrolling between pages in single or
double-page view. Click Show Cover Page to navigate to the first page of the current
report.

Export
The Export buttons let you export the document for sharing with others. Click Export and
select an output type to export the document in the specified file format, using the Export
Document dialog box to specify the location for the output file. Click Send to export the
document in an available format and send the document in an email.

Report Viewer Button Bar
While viewing a report, you can use buttons in the Report Viewer button bar to navigate

through the report, set viewing options, zoom in and out of parts of the report, and print or

export the report.
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Print
Use the Print andQuick Print buttons to control report printing. The Print button displays
the Windows Print dialog box, set the printer and other print settings for precise printing.
ClickQuick Print to send the report to your default printer with specified print settings.

Navigation
Use these buttons to control navigation through the report.

Click Previous Page and Next Page to navigate through the document one page at a
time. Click First Page and Last Page to go to the first and last pages in the document.

For some reports you can click Navigation Pane to display a navigation pane next to the
Report Viewer, which lets you find specific data on the report.

See Report Navigation.

Zoom
Use these buttons to control the magnification for the report. The Zoom In and Zoom Out
buttons increment or decrement the magnification. Use the Zoom button to view the

report at a specific magnification, view the entire page, or display pages using the entire

Report Viewer pane width.
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View
Use the Page Layout button to specify the number of pages to display within the Report
Viewer pane, or to select the number of pages to show side-by-side. The Enable
Continuous Scrolling button lets you control scrolling between pages in single or
double-page view. Click Show Cover Page to navigate to the first page of the current
report.

Export
The Export buttons let you export the document for sharing with others. Click Export and
select an output type to export the document in the specified file format, using the Export
Document dialog box to specify the location for the output file. Click Send to export the
document in an available format and send the document in an email.

Report Navigation
Reports that include user groups let you use the available Navigation pane to further

refine or locate data needed for your security audit. This is especially useful when working

with very long documents, or when you need to quickly find specific data to complete your

security audits.

The Report Navigation pane is available with the following reports:

l User’s Group Membership

l User’s Security Roles

Tabs in the Report Navigation pane are as follows.
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Document Map Tab
Use this tab to view a heading outline of the report and to navigate to specific headings in

the current report. To navigate to a specific header, simply click the name of the header in

the Document Map tab. All levels of headings display in the tab, so you can quickly move

between headings in the report.

Pages Tab
Click this tab to view thumbnail sketches of each page in the current report. You can click

on any page in the thumbnails to navigate to that page.
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Search Results
The Navigation pane lets you search for specific data and see the number of hits there are

in the document for your search. Use the Up and Down arrows in the search results to

navigate through the matched search results. The Search Results pane shows each
instance of a search hit in the document. As you go through search results, the Search
Results tab highlights the current search hit instance, and the report automatically
navigates to the page containing the search hit.

Report Navigation
Reports that include user groups let you use the available Navigation pane to further

refine or locate data needed for your security audit. This is especially useful when working

with very long documents, or when you need to quickly find specific data to complete your

security audits.
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The Report Navigation pane is available with the following reports:

l User’s Group Membership

l User’s Security Roles

Tabs in the Report Navigation pane are as follows.

Document Map Tab
Use this tab to view a heading outline of the report and to navigate to specific headings in

the current report. To navigate to a specific header, simply click the name of the header in

the Document Map tab. All levels of headings display in the tab, so you can quickly move

between headings in the report.

Pages Tab
Click this tab to view thumbnail sketches of each page in the current report. You can click

on any page in the thumbnails to navigate to that page.
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Search Results
The Navigation pane lets you search for specific data and see the number of hits there are

in the document for your search. Use the Up and Down arrows in the search results to

navigate through the matched search results. The Search Results pane shows each
instance of a search hit in the document. As you go through search results, the Search
Results tab highlights the current search hit instance, and the report automatically
navigates to the page containing the search hit.

Report Navigation
Reports that include user groups let you use the available Navigation pane to further

refine or locate data needed for your security audit. This is especially useful when working

with very long documents, or when you need to quickly find specific data to complete your

security audits.
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The Report Navigation pane is available with the following reports:

l User’s Group Membership

l User’s Security Roles

Tabs in the Report Navigation pane are as follows.

Document Map Tab
Use this tab to view a heading outline of the report and to navigate to specific headings in

the current report. To navigate to a specific header, simply click the name of the header in

the Document Map tab. All levels of headings display in the tab, so you can quickly move

between headings in the report.

Pages Tab
Click this tab to view thumbnail sketches of each page in the current report. You can click

on any page in the thumbnails to navigate to that page.
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Search Results
The Navigation pane lets you search for specific data and see the number of hits there are

in the document for your search. Use the Up and Down arrows in the search results to

navigate through the matched search results. The Search Results pane shows each
instance of a search hit in the document. As you go through search results, the Search
Results tab highlights the current search hit instance, and the report automatically
navigates to the page containing the search hit.
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Report Navigation
Reports that include user groups let you use the available Navigation pane to further

refine or locate data needed for your security audit. This is especially useful when working

with very long documents, or when you need to quickly find specific data to complete your

security audits.

The Report Navigation pane is available with the following reports:

l User’s Group Membership

l User’s Security Roles

Tabs in the Report Navigation pane are as follows.

Document Map Tab
Use this tab to view a heading outline of the report and to navigate to specific headings in

the current report. To navigate to a specific header, simply click the name of the header in

the Document Map tab. All levels of headings display in the tab, so you can quickly move

between headings in the report.
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Pages Tab
Click this tab to view thumbnail sketches of each page in the current report. You can click

on any page in the thumbnails to navigate to that page.
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Search Results
The Navigation pane lets you search for specific data and see the number of hits there are

in the document for your search. Use the Up and Down arrows in the search results to

navigate through the matched search results. The Search Results pane shows each
instance of a search hit in the document. As you go through search results, the Search
Results tab highlights the current search hit instance, and the report automatically
navigates to the page containing the search hit.
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User Reports

NOTE: Sensitive data in reports graphics shown in this section has been blurred
for data protection.

See User and Group Report Filters for information on applying filters to reports.

Data shown on User reports is defined in OneStream (System > Security > Users)
when setting up system security roles.

Total Users
This report lists critical status information for each user defined in OneStream. Each user

created within the start date/end date range displays in the report. Records display in

alphabetical order by name. Each user record in the report also includes the external user

name, the user’s email address, the date the record was created, and whether the user is

enabled or disabled in the system.

The report also lists the total number of users currently defined in OneStream on the top

of the report for quick reference.
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Enabled Users
This report lists all users in OneStream who are currently enabled. Users display in

alphabetical order by name. The report shows the total number of enabled users, and

shows the extended user name and email address for each enabled user, along with the

time stamp of when the user record was created.

Disabled Users
This report lists all users in OneStream who are currently disabled. Records display in

alphabetical order by name. The report shows the total number of disabled users at the

top of the report for quick reference, and shows the extended user name and email

address for each enabled user, along with the time stamp of when the user record was

disabled.

Security Audit Reports Setup Instructions 51

User Reports



Native Users
Every OneStream user is assigned a user ID. Users can be added as native users or as

references to users stored in user repositories such as an Active Directory. This report

shows those users defined as native users in OneStream.

Records display in alphabetical order by name. The total number of native users displays

at the top of the report for quick reference. Each native user record on the report also

shows the user’s email address and the enabled status, along with the time stamp of

when the user record was created.

Added Users
This report lists the users added within a specified date range. Users display in

alphabetical order by name. The total number of users added within the date range

displays at the top of the report for quick reference, along with the specified report date

range. Each user shown on the report also shows the user’s email address and who

added the user, along with the time stamp of when the user was added.
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Deleted Users
This report lists the users deleted within a specified date range. Records display in

alphabetical order by name. The total number of users deleted within the date range

displays at the top of the report for quick reference, along with the specified report date

range. Each deleted user on the report also shows the user’s email address and who

deleted the user, along with the time stamp of when the user was deleted.
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Updated Users
This report lists the users whose user information was updated within a specified date

range. The total number of users updated within the date range displays at the top of the

report for quick reference, along with the specified report date range. Each updated user

record on the report also shows the audit user who last updated the user, along with the

time stamp of when the user was updated.
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Inactive Users
This report lists the users who have not logged onto the system since the start date

specified for the report. Records display in alphabetical order by name. The total number

of users who have not logged on since the start date displays at the top of the report for

quick reference, along with the number of users who did not log on during that period. A

blank last logon date means the user has never logged on.

Each added user record on the report also shows the user’s last logon date, who created

the user record, along with the time stamp of when the user record was created. You can

further filter the users who appear on the report by their enabled status.

User List
This report shows critical status information for each user defined in OneStream. Each

user created within the start date/end date range displays in the report. Records display in

alphabetical order by name.

You can further filter the users that display in the report by their enablement status, and by

any of the free form text fields. Filtering criteria used for the report displays at the top of
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the report. Each user record in the report also includes the user’s email address, the

enablement status, and any text entered in any of the free form text fields.
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User List – Grid View
The User List – Grid View Report shows all information about all user records in a grid.

Use grid features to create a highly customized report that shows exactly which user

records you want to see, what data you want to see, and how you want to see those user

records grouped.

Manage Grid Items
The grid in the User List - Grid View report provides several features that let you group,

filter, and display the data, items and columns in the grid.

Group Grid Items
In User List - Grid View report grid, you can drag and drop column headers to the dark

blue bar on top of the column headers to group and display grid items by the dropped

column.
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Any column or combination of columns can be used. For example, to group by the user

and whether the user is enabled in the system, first drag the User column head up to the

bar at the top of the grid, then do the same with the IsEnabled column head. Dragging and

dropping any column head to this area changes it to the Grouped by bar and displays the

column head names that you drop into it.

The following image shows the grid in the User List - Grid View report with the tasks

grouped first by the IsEnabled column value (which returns False or True), then by the
Updated By column value. Grouped list items display in alphabetical order.

Column groupings are updated and display as soon as the column is dropped into the bar.

When more than one grouping is used, groupings display as nested within its higher-level

grouping. For example, the previous image lists the users by whether the user is enabled

in OneStream, then within each status, users are grouped by the date the user’s record

was updated.

Expand or collapse grouped items by clicking Expand and Collapse on the top left of
each grouping.
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Any column groupings you make are retained between Security Audit Reports sessions.

Groupings stay in place until you change them or remove them.

To remove a grouping, hover over the column group you want to remove, then click the x

that appears in the group box. You can also click the column group head in the Grouped

by bar and drag it anywhere outside of the bar to remove it. Removing all groupings

restores the list to its original state.

You can also change the list of items within groupings between ascending order and

descending order by clicking the ascending/descending widget on the top of the column

group box.

When grouping grid items by multiple groups, you can also easily change grouping

hierarchy by dragging and dropping a grouping box to the desired grouping level.

Filter Items that Display in a Grid
Grids allow you to use filters to display a subset of the grid’s items. This is useful when

working with large numbers of items in a grid and lets you easily focus on the items you

need to work with.

Any column reordering stays in state until you change it. In other words, column ordering

is remembered and retained from session to session until changed.

Any grid with columns that include the Filter button in the column head let you use

filtering criteria to display the items that meet the filtering criteria you define for that

column.
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In any grid column, you can click the Filter button to display the Filter Criteria dialog

box.

Start by selecting the specific items to include in the filter. Items that you can choose from

are based on specific item values available in the selected column. You can select all

items, specific items, or a single item for filtering.

Use the remaining fields to optionally build a filter expression to further filter the items to

display in the grid. Use the fields to define the logical operators and relational operators in

the filter expression. When a logical operator requires a value, use the text box below the

logical operator list box to enter the value. Click the button next to the value if you want

case matching to apply to the entered value.

Click Filter to apply the filter to the selected task group or task list.
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Set and Order Grid Columns
You can click the Column Settings button to determine which columns to display and the
left-to-right order in which the columns display in the User List – Grid View report. This

allows you to easily focus on just the data you need to see.

The Column Settings dialog box lets you select the columns to display in the Task
Groups and Tasks panes of the Task Administration page.

Select columns names in either the Visible Columns list or the Hidden Columns list and
use the left-to-right and right-to-left arrows to move the selected columns names from one

list to the other. You can hold down the SHIFT key to select multiple sequential column

names, or you can hold down the CTRL key and select multiple non-sequential columns

names. Then use the arrows to move the selected column names from one list to the

other. Use the Add All Items or Remove All Items arrows to move all items from one list

to the other.

The Visible Columns list shows the order in which columns display. To reorder a column
in the display, select the heading name from the Visible Columns list, then use theMove
Up andMove Down buttons to set where the selected column displays.

See Manage Grid Items.
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User List – Grid View
The User List – Grid View Report shows all information about all user records in a grid.

Use grid features to create a highly customized report that shows exactly which user

records you want to see, what data you want to see, and how you want to see those user

records grouped.

Manage Grid Items
The grid in the User List - Grid View report provides several features that let you group,

filter, and display the data, items and columns in the grid.

Group Grid Items
In User List - Grid View report grid, you can drag and drop column headers to the dark

blue bar on top of the column headers to group and display grid items by the dropped

column.
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Any column or combination of columns can be used. For example, to group by the user

and whether the user is enabled in the system, first drag the User column head up to the

bar at the top of the grid, then do the same with the IsEnabled column head. Dragging and

dropping any column head to this area changes it to the Grouped by bar and displays the

column head names that you drop into it.

The following image shows the grid in the User List - Grid View report with the tasks

grouped first by the IsEnabled column value (which returns False or True), then by the
Updated By column value. Grouped list items display in alphabetical order.

Column groupings are updated and display as soon as the column is dropped into the bar.

When more than one grouping is used, groupings display as nested within its higher-level

grouping. For example, the previous image lists the users by whether the user is enabled

in OneStream, then within each status, users are grouped by the date the user’s record

was updated.

Expand or collapse grouped items by clicking Expand and Collapse on the top left of
each grouping.
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Any column groupings you make are retained between Security Audit Reports sessions.

Groupings stay in place until you change them or remove them.

To remove a grouping, hover over the column group you want to remove, then click the x

that appears in the group box. You can also click the column group head in the Grouped

by bar and drag it anywhere outside of the bar to remove it. Removing all groupings

restores the list to its original state.

You can also change the list of items within groupings between ascending order and

descending order by clicking the ascending/descending widget on the top of the column

group box.

When grouping grid items by multiple groups, you can also easily change grouping

hierarchy by dragging and dropping a grouping box to the desired grouping level.

Filter Items that Display in a Grid
Grids allow you to use filters to display a subset of the grid’s items. This is useful when

working with large numbers of items in a grid and lets you easily focus on the items you

need to work with.

Any column reordering stays in state until you change it. In other words, column ordering

is remembered and retained from session to session until changed.

Any grid with columns that include the Filter button in the column head let you use

filtering criteria to display the items that meet the filtering criteria you define for that

column.
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In any grid column, you can click the Filter button to display the Filter Criteria dialog

box.

Start by selecting the specific items to include in the filter. Items that you can choose from

are based on specific item values available in the selected column. You can select all

items, specific items, or a single item for filtering.

Use the remaining fields to optionally build a filter expression to further filter the items to

display in the grid. Use the fields to define the logical operators and relational operators in

the filter expression. When a logical operator requires a value, use the text box below the

logical operator list box to enter the value. Click the button next to the value if you want

case matching to apply to the entered value.

Click Filter to apply the filter to the selected task group or task list.
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Set and Order Grid Columns
You can click the Column Settings button to determine which columns to display and the
left-to-right order in which the columns display in the User List – Grid View report. This

allows you to easily focus on just the data you need to see.

The Column Settings dialog box lets you select the columns to display in the Task
Groups and Tasks panes of the Task Administration page.

Select columns names in either the Visible Columns list or the Hidden Columns list and
use the left-to-right and right-to-left arrows to move the selected columns names from one

list to the other. You can hold down the SHIFT key to select multiple sequential column

names, or you can hold down the CTRL key and select multiple non-sequential columns

names. Then use the arrows to move the selected column names from one list to the

other. Use the Add All Items or Remove All Items arrows to move all items from one list

to the other.

The Visible Columns list shows the order in which columns display. To reorder a column
in the display, select the heading name from the Visible Columns list, then use theMove
Up andMove Down buttons to set where the selected column displays.

See Manage Grid Items.
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User Change Audit
The User Change Audit provides details on each change made to user records in within

the specified date range. Each change record shows the user record attribute that

changed, the attribute’s old and new value, the audit user who last updated the user

record, along with the time stamp of when the user record was changed. Changes are

listed by user.
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User’s Group Membership
This report lists users and shows information about each of the groups to which each user

belongs. For each user, the associated groups display along with an indicator that tells

whether the group is an exclusion group. Records that appear in the report are based on

the specified date range. You can also use the user name or description, the user’s

enabled status, and any of the freeform text fields to further filter user records that appear

on the report.
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User’s Group Change Audit
The User’s Group Change Audit provides details on each change to user records that

were made within the specified date range. For each user, the report lists each change

made to the user’s security groups. Each change shows the change action, the audit user

who made the change, along with the time stamp when the user record was changed.

User Security Roles
The User Security Roles Report is a simple list of all the security roles assigned to each

user. Users display on the report in alphabetical order.

You can also use the user name or description, the user’s enabled status, and any of the

free form text fields to further filter user records that appear on the report.
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User Deactivation
The User Deactivation report shows all the enabled users that have not logged into

OneStream and are set to expire based on remaining inactivity days from the current

date, which displays at the top of the report as the Run Date. The total number of users

also displays at the top of the report.

No filters are available for this report. The report displays the deactivation status based on

the current date.

Records on the report are ordered by user deactivation date. Users whose deactivation

date are 10 or less days from the report run date display first and appear in red. Next are

users whose deactivation date is between 10 to 20 days from the report run date. These
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appear in orange. Finally, users whose deactivation date is more than 20 days from report

run date display in black.

For each user on the report, the name, description and user’s email displays, as well as

the UTC time stamp of the user’s last login, the number of days the user has until

deactivation due to inactivity, and the UTC time for the deactivation.

The report does not show the last login time stamp for users that are enabled but have

never logged in. If a user’s status settings are not defined in OneStream

(System|Security|Users|Status) which are set in the server configurations, no data

appears on the report.
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Group Reports

NOTE: Sensitive data in reports graphics shown in this section has been blurred
for data protection.

See User and Group Report Filters for information on applying filters to reports.

Data shown on Group reports is defined in OneStream (System > Security > Groups)
when setting up system security roles.

Total Groups
This report lists critical status information for each group defined in OneStream. Each

group record created within the start date/end date range displays in the report. Groups

display in alphabetical order by name. Each group listed in the report shows the

timestamp when the group was created and the timestamp of the last update to that

group.

The IsExclusion field indicates whether the group is an exclusion group. Exclusion groups

are used in OneStream to exclude a group of people from access to a group. See System

Administration in the Design and Reference Guide for more information.

The report also lists the total number of users currently shown on the report.
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Added Groups
This report lists the groups that were added within a specified date range. Groups display

in alphabetical order by name. The total number of groups added within the date range

displays at the top of the report for quick reference, along with the specified report date

range. Each group record on the report also shows the timestamp when the group was

created and the time stamp of when the user record was last updated.

The IsExclusion field indicates whether the group is an exclusion group. Exclusion groups

are used in OneStream to exclude a group of people from access to a group. See System

Administration in the Design and Reference Guide for more information on Exclusion

Groups.

Security Audit Reports Setup Instructions 73

Group Reports



Deleted Groups
This report lists all users in OneStream who have been deleted within the specified date

range. The specified date ranges display at the top of the report along with the total

number of groups that were deleted during that date range for quick reference. For each

deleted group, the report shows the audit user along with the audit time stamp.

The IsExclusion field indicates whether the group is an exclusion group. Exclusion groups

are used in OneStream to exclude a group of people from access to a group. See System

Administration in the Design and Reference Guide for more information on Exclusion

Groups.
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Updated Groups
This report lists the groups whose information was updated within a specified date range.

The total number of groups updated within the date range displays at the top of the report

for quick reference, along with the specified report date range. Each updated group

shown on the report also shows the audit user who last updated the group, along with the

time stamp of when the group was updated.

The IsExclusion field indicates whether the group is an exclusion group. Exclusion groups

are used in OneStream to exclude a group of people from access to a group. See System

Administration in the Design and Reference Guide for more information on Exclusion

Groups.
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Group List
This report lists critical status information for each group and exclusion group defined in

OneStream. Each group created within the start date/end date range displays in the

report. Records display in alphabetical order by group name. For each group defined in

OneStream, the report shows the group’s children, any users belonging to the group, and

whether the group is enabled.

You can further filter the groups that display in the report by the group name or description
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Group Change Audit
The Group Change Audit report provides details on each change to group records in

OneStream that were made within the specified date range. The specified report date

range displays at the top of the report for quick reference. For each group listed in the

report, the action performed on the group displays with the audit user who made the

change, along with the time stamp of when the user record was changed.
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Help & Miscellaneous Information
This page contains additional solution documentation for Security Audit Reports,

including database migration information.

Display Settings
OneStream Solutions frequently require the display of multiple data elements for proper

data entry and analysis. Therefore, the recommended screen resolution is a minimum of

1920 x 1080 for optimal rendering of forms and reports.

Additionally, OneStream recommends that you adjust the Windows System Display text

setting to 100% and do not apply any Custom Scaling options.

Package Contents & Naming Conventions
The package file name contains multiple identifiers that correspond with the platform.

Renaming any of the elements contained in a package is discouraged in order to preserve

the integrity of the naming conventions.

Example Package Name: SAR_PV6.2.0_SV101_PackageContents.zip

Identifier Description

SAR Solution ID

PV6.2.0 Minimum Platform version required to run solution
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Identifier Description

SV101 Solution version

PackageContents File name

Solution Database Migration Advice
A development OneStream application is the safest method for building out a solution

with custom tables such as this one. The relationship between OneStream objects such

as workflow profiles and custom solution tables is that they point to the underlying

identifier numbers and not the object names as seen in the user interface. Prior to the

solution configuration and to ensure the identifiers match within the development and

production applications, the development application should be a recent copy of the

production application. Once the development application is created, install the solution

and begin design. The following process below will help migrate the solution tables

properly.

See also:Managing a OneStream Environment in the Design and Reference Guide.

1. In the production OneStream application, install the solution and create the data

tables. See Configure the OneStream Application Server for Database Server

Connection settings and installation details.

2. Data tables are created in the OneStream Development application during the

solution installation. Using the Microsoft Data Migration Assistant, copy the data

from the tables to the Production Microsoft SQL Server Database. Only the

Microsoft SQL Administrator should run the migration assistant.
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IMPORTANT: This process has the potential to overwrite existing table data in
the production application database if data already exists.
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OneStream Solution Modification
Considerations
A few cautions and considerations regarding the modification of OneStream Solutions:

l Major changes to business rules or custom tables within a OneStream Solution will

not be supported through normal channels as the resulting solution is significantly

different from the core solution.

l If changes are made to any dashboard object or business rule, consider renaming it

or copying it to a new object first. This is important because if there is an upgrade to

the OneStream Solution in the future and the customer applies the upgrade, this will

overlay and wipe out the changes. This also applies when updating any of the

standard reports and dashboards.

l If modifications are made to a OneStream Solution, upgrading to later versions will

be more complex depending on the degree of customization. Simple changes such

as changing a logo or colors on a dashboard do not impact upgrades significantly.

Making changes to the custom database tables and business rules, which should

be avoided, will make an upgrade even more complicated.
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